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ORIENTATION TO THE WEB-BASED TRAINING 
Welcome to the CAL MSAF Help. This tutorial will guide you through the key features that enable you to 
successfully navigate within this and other lessons. This tutorial is designed to apply across all lessons; 
therefore, not all features and functionality described will apply to the lesson you are currently taking.  
 
When you access each lesson, the following screen will appear. This is the Introductory Presentation 
(described below). 
 

 

Introductory Presentation  
When you navigate to each lesson, the Introductory Presentation will appear. Depending on the speed of 
your network connection/computer, an animated icon may appear beforehand indicating that your 
computer is loading the presentation. When the presentation has fully loaded, audio narration plays in 
synchronization with the appearance of a series of photos. You can skip this presentation by selecting the 
Skip button. 
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Welcome Tab 
When the introductory presentation concludes (or you select the Skip button), you will be directed to a 
Lesson Overview screen. This screen displays the learning objectives and the FM 6-22 competency 
components covered in the lesson you are currently taking.  
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Topic Menu Tab 
Select the Topic Menu tab to view a listing of the instructional topics that make up the lesson. Then, 
select each topic to launch your learning experience. Each topic will open in the same browser window.  
 

 
 
Glossary, Help, and Exit Buttons 
 

These buttons are located in the upper right hand corner of the user interface. 
When you select the Glossary button, a Glossary PDF appears in a separate 
browser window containing the terms and definitions of select words used in 
the MSAF lessons. The Help button opens this Help PDF in a separate 
browser window. The Exit button closes the lesson. 

 
Topic Progress Indicators 
The Topic Progress Indicators show whether or not you have started, are in the progress of completing, 
or have completed a particular topic. 
 

 
This indicator is in the “incomplete” state, meaning that you have not yet started the topic. 

 

This indicator is in the “in progress” state, meaning that you have started but not yet completed 
the topic. 
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This indicator is in the “completed” state, meaning that you have visited all of the required 
screens in the topic. 

 
USING THE NAVIGATION TOOLBAR AND ASSOCIATED FEATURES 
A navigation bar containing five buttons appears on the bottom right of each lesson screen. A Progress 
Bar also appears in the upper right hand corner of each screen. These features will assist you in 
effectively navigating through each lesson. 
 
Closed Captioning Button 

 

This left-most button is titled the “CC” button. When you select it, a popup appears in a 
separate browser window. It contains the closed captioning (CC) for the audio narration 
accompanying each screen. 

 
Play, Pause, and Replay Button 

 

The Pause button appears as two vertical white lines when the session is active. When the 
two vertical lines are present, you can select this button to pause the audio narration. 

 

The Play button appears as a triangle when the session is paused. Select this button to 
continue playing the audio narration.   

 

The Replay button appears as an arrow with a circle around it. When the audio narration for 
a particular screen has concluded, select this button to replay it. 

 
Previous Menu Button 

 
The Previous Menu button appears as a flowchart with three connected boxes. This button 
allows you to navigate back to a sub-topic menu within a particular lesson.  

 
If the Previous Menu button is dimmed, it means that the button is disabled on that screen 
(i.e., there is no sub-topic menu to which you can navigate). 

 
Back and Next Buttons 

 
The Back and Next buttons enable you to move ahead to a new screen or back to a 
previous screen. (Do NOT use the browser's Back and Forward buttons to navigate within 
the lesson screens.) This will ensure that your path through the lesson is properly managed. 

 

 

 

If either the Next or Back button is dimmed, it means the button is disabled on that screen. It 
may mean that you need to complete an action onscreen in order to continue. Refer to the 
navigation prompt located in the lower left corner of the user interface to help you determine 
how to proceed. 

 
 
Progress Bar 

The Progress Bar displays in the upper right corner of each 
lesson screen. It indicates the amount of the lesson that you 
have completed and helps you gauge your movement through 
it.  
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MOVING THROUGH THE LESSON 
On some screens, you will select the Next button at the bottom of the screen when you are ready to 
proceed. Other screens give you the option of selecting an image or an onscreen link, which then directs 
you to a new branched screen containing additional information. Each screen contains a navigation 
prompt located in the lower left hand corner of the user interface; the prompt provides instructions on how 
to proceed. Make sure to refer to these instructions as you proceed through each lesson.  
 
When you see a dimmed Next button, it means that you need to complete an action/exercise onscreen to 
continue. Refer to the navigation prompt to help you determine how to proceed.  
 
At any time, you may access the following additional resources without losing your place in the module: 
 

• Select the Glossary button to look up a term.  
• Select the Help button to open up this Help PDF. 
• Select the arrow on the left hand side of each screen to view the Table of Contents. This listing 

indicates where you are within the lesson and allows you to “jump” to any of the screens listed.  
o Note that not all screens are listed in the Table of Contents. In situations where you are 

asked to answer a question in order to proceed, the answer you choose and the new 
screen(s) you proceed to based on that answer will not appear in the Table of Contents; 
this is because their screen titles may reveal the most appropriate answer to the question 
that precedes them. 

 
 
 
 
 
 
 
 
 
 
 
 
 
Voices from the Field/Avatars 
Within some lessons, you will come across “Voices from the Field,” which include vignettes told by 
different Soldier avatars. Depending on the speed of your network connection/computer, an animated 
icon may appear when you first navigate to each Voices screen indicating that your computer is loading. 
When the Voices screen has fully loaded, you will be asked to select each Soldier’s image to start the 
accompanying audio narration.  
 

 
 

Page 7 of 17 



                                                                                                                                                CAL MSAF Help 

Links and Hot Spots  
On many screens, the navigation prompt in the lower left-hand corner of the user interface will indicate 
that there are selectable areas/text/images on the screen (a.k.a., links/hot spots) for you to select to learn 
more. Depending on the screen you are on, your selection of these links/hot spots will do one of the 
following: 

 
• Take you to a new screen (e.g., a new topic/sub-topic) within the same user interface, 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Open up additional instructional content in a new pop-up window, 
 
 
 
 
 
 
 
 
 
 
 
 

• Open up a PDF document in a new window, or 
 

• Open up a new Internet browser window directing you to the selected website page. 
 
Also note that new windows open in a separate browser window; your current window containing the 
course will remain open.  
 
To help you determine what links/hot spots you have visited, you will see one of the following: 

 
• A Sub-Topic Progress Indicator. These indicators are similar in appearance and functionality to 

the Topic Progress Indicators that appear on the Topic Menu page. However, these indicators 
appear next to onscreen links and have only two states:  
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Incomplete, meaning that you have not yet visited the link, OR 

 
Complete, meaning that you have visited the link. 

 
• Progress Checkmarks. When you select a link/hotspot, a checkmark will appear over the image 

indicating that you have done so.  
 
“Choose Your Own Adventure” Branching Screens 
On some screens, you will be asked to select an answer in order to proceed. This means that, based on 
your selection, you will be directed to a new screen within the same user interface. In some lessons, you 
will immediately learn whether or not you made the correct selection based upon the screen content; in 
others, you will proceed down a path for several screens in order to learn the impact of your choice. 
When you reach the end of the path, you will either be told what the correct or “best” answer should have 
been, or you will be directed back to the original screen and asked to make a new selection. 
 
Note that, on these questions, the answer you choose and the new screen(s) you proceed to based on 
that answer may not appear in the Table of Contents. This is because the screen titles that correspond to 
each choice may reveal which choice is correct or best.  
 
                  

This navigation 
prompt tells you that 
you have to select an 
option to continue. 

The Next button is dimmed, 
indicating that you should 
look to the navigation prompt 
to determine how to proceed. 

After selecting an answer choice and the Submit button, you are directed to one of the three screens above.  
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Delayed Branching with Audio Interactions 
On some “Choose Your Own Adventure” branching screens, you be asked to make a selection and select 
the Submit button, at which point you will advance to the next screen and hear avatar/character audio 
specific to your choice. 
 

 
 
 

 
 

Selection of the Submit button 
advances you to the next screen and 
plays avatar/character audio. 

When the avatar/character audio 
concludes, the main narrator begins 
and the onscreen content for the 
current screen appears. 
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Type and Compare 
On some screens, you will be asked to record your answers, suggestions, or thoughts about a 
scenario/situation on an onscreen notepad. Then, by selecting the Compare button, suggested answers 
or considerations will appear on the right hand side of the screen. 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In other cases, you will be asked to record your answers, suggestions, or thoughts about a 
scenario/situation on an onscreen notepad and then select an Ask the Expert button. 

 
 
 
 
 
 
 
 
 
 
 

After recording your response and selecting the Compare 
button, suggested answers appear on the right hand side of 
the screen. 

After recording your 
response and selecting the 
Ask the Expert button, you 
will receive a narrated 
response.

Select a Button to Receive Onscreen Feedback 
Some screens ask that you respond to a question by selecting a radio button, at which point feedback 
appears onscreen below the question. Once you have made one selection, you can select any and all 
other options to view the feedback associated with each answer choice. 
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Select a Notebook/Folder Tab to Learn More 
On some screens, a selectable notebook/folder tab appears on the bottom of the user interface. Selection 
of this tab generates a pop-up, a PDF in a separate window, or directs you to a new screen. You are 
encouraged to select these tabs when they appear, as they often contain important supplementary 
information. The onscreen prompt and the audio narration also direct you to select these tabs when they 
appear. 
 

 
 

In this example, selection of the 
Notebook/Folder Tab directs you to a new 
screen with important supplementary 
information.
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COMPLETING KNOWLEDGE CHECKS 
Knowledge Check screens provide exercises to help present and review the content covered in the 
lesson. Text at the top of the screen gives instructions on how to complete each exercise. Some 
questions require you to select additional buttons in order to answer the question. You may need to listen 
to additional audio narration or open a separate PDF document.  
 
You will have two attempts to answer each knowledge check question correctly. After selecting your 
answers and the Submit button, a popup box will appear in a separate browser window with feedback. 
After reading the feedback, select the Close button in the lower right hand corner of the box to proceed. 
You will encounter four main types of Knowledge Checks (described below). 
 
Multiple-Choice 
These Knowledge Check questions require you to read a question or scenario and then choose the 
correct answer by selecting the appropriate radio button. These questions have only one correct answer. 
 

 
 
Multiple Choice-Multiple Answer 
These Knowledge Check questions require you to read a question or select an image, then choose the 
correct answers by selecting the appropriate checkbox(es). These questions will have more than one 
correct answer. This is indicated in the text at the top of the screen (e.g., “Select all responses that apply, 
then select the Submit button.”). If your first attempt at answering the question is only partially correct, 
your correct responses will remain displayed while your incorrect responses will be cleared for your 
second attempt. 
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Drag and Drop 
These Knowledge Check questions require you to answer the question by selecting each answer choice 
on the left side of your screen, dragging it into the appropriate category on the right side of the screen, 
and then “dropping” or releasing it into that category. If your first attempt at answering the question is only 
partially correct, your correct responses will remain displayed while your incorrect responses will be 
cleared for your second attempt. 
 

 
 
Matching 
These Knowledge Check questions require you to match a series of statements with corresponding terms 
or categories. You are asked to type the corresponding letter into the appropriate field. If your first attempt 
at answering the question is only partially correct, your correct responses will remain displayed while your 
incorrect responses will be cleared for your second attempt. 
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LESSON LENGTH AND SUCCESSFUL COMPLETION 
When you reach the end of each topic within a lesson, a Topic Summary screen lists the instructional 
content that was covered in that topic. You are then instructed to select the Next button, which directs you 
back to the Topic Menu.  
 
Completion of each lesson is not recorded electronically. The lessons are intended for self-development 
and can be explored at any time, either in full or in part, depending on your developmental needs.  
 
Note that lessons can take anywhere from 45 minutes to 3.5 hours to complete in full.  
 

SYSTEM SPECIFICATIONS AND SECURITY RESTRICTIONS 
To ensure that all lessons and associated features are fully functional on your computer, ensure that all 
system specifications and security restrictions are set appropriately (see below). 
 
Setting Screen Display 
The steps below explain how to set Microsoft Windows to a screen resolution of 1024 x 768 pixels, which 
is the minimum resolution required to view this course. Most monitors support this setting or higher. To 
change your screen resolution to a higher setting, follow these steps: 
 

1. From the "Start" menu, choose "Control Panel".  
2. Double-click on the "Display" icon.  
3. Select the "Settings" tab.  
4. Under "Screen Area" or "Screen Resolution", move the indicator to reflect at least "1024 by 768 

pixels" or higher.  
5. Under "Color Quality" or "Colors", select "Highest (32 bit)" or higher (High Color (64,000 colors) or 

True Color (16 million).  
6. Select "OK" to save the new setting and close the Control Panel window. If you are prompted to 

restart your computer, do so.  
 

If you are having trouble finding the settings or getting them to work, it is possible that your monitor does 
not support 1024 x 768 screen resolution. In some cases, selecting different driver software for your 
monitor may enable 1024 x 768 resolution. Consult your system's documentation for more information on 
this topic. 
 
Web Browser 
You must have Internet Explorer 6.X (or higher) in order to use the courseware. Additionally, Javascript, 
Active X, and cookies must be enabled. “Pop-up blocker" software must be disabled or programmed to 
accept pop-ups. Refer to the instructions below on how to enable/disable these features. 
 
Enabling Javascript 

This course makes heavy use of JavaScript for interactivity and navigation. If you have gotten this 
far, JavaScript is already enabled in your browser. If you need instructions on how to enable 
JavaScript, do the following:  
 
For Internet Explorer Version 6.X:  
 

1. In your Internet Explorer browser window, select “Internet Options” from the “Tools” menu.  
2. Find the “Security” section by reviewing the various tabs available (the tab names will vary in 

different releases of Internet Explorer). 
3. In the "Security level for this zone" section, choose “Custom Level.” 
4. Scroll down to the setting titled "Scripting", and under "Active Scripting" select "Enable".  
5. Select “OK.” 
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Enabling ActiveX Controls 
Your browser window may display the following message: “To help protect your security, Internet 
Explorer has restricted this webpage from running scripts or ActiveX controls that could access your 
computer. Click here for options…” 
 
For Internet Explorer Version 6.X: 
 

1. Select the message bar and then, select, “Allow Blocked Content…” 
2. Next, a popup Security Warning box will likely display that says: “Allowing active content 

such as script and ActiveX controls can be useful, but active content might also harm your 
computer. Are you sure you want to let this file run active content? Yes / No” 

3. Select “Yes” within this popup box. 
 
Enabling Cookies 

A cookie is data stored on your computer when you use the Internet. A session cookie, also called a 
transient cookie, is a cookie that is erased when you close your Web browser. The session cookie is 
stored in temporary memory and is not retained after the browser is closed. Session cookies do not 
collect information from your computer. They typically store information in the form of a session 
identification that does not personally identify you. A cookie cannot retrieve any other data from your 
hard drive, pass on computer viruses, or capture your email address. 
 
In instances where a Web application has a time limit and/or there are multiple pages where you are 
entering information, browsers need to know that all of the pages within the application are actually 
part of one form. It does not save the information you are entering on your computer. 
 
For Internet Explorer Version 6.X: 
 

1. In your Internet Explorer browser window, select “Internet Options” from the “Tools” menu. 
2. Find the “Privacy” section by reviewing the various tabs available (the tab names will vary in 

different releases of Internet Explorer). 
3. Ensure that the Setting is not set to “Block All Cookies.” If it is, adjust the slider to the 

“Medium” setting. 
4. Select “Apply” and then, “OK” to save all changes. 

 
If you are still having problems, you can also add specific websites to a list of cookie-allowed sites. 
To do so: 
 

1. In your Internet Explorer browser window, select “Internet Options” from the “Tools” menu. 
2. Find the “Privacy” section by reviewing the various tabs available (the tab names will vary in 

different releases of Internet Explorer). 
3. Within the “Privacy” section, select “Sites,” which opens “Per Site Privacy Actions.”  
4. Enter the website address that you want to allow in the “Address of website” field. 
5. Select “Allow,” followed by “OK” to close “Per Site Privacy Options.” 
6. Next, select “Advanced.” If the “Override automatic cookie handling” is checked, be sure to 

select Accept for “First-party cookies” and “Third-party cookies.”  
7. Select “OK” to close “Advanced Privacy Options,” followed by “OK” to close “Internet 

Options.” 
 

Accepting Pop-ups/Disabling “Pop-up Blocker” Software 
Pop-up Blocker is a feature in Internet Explorer that lets you limit or block most pop-ups. You can 
choose the level of blocking you prefer, from blocking all pop-up windows to allowing the pop-ups 
that you want to see. When Pop-up Blocker is turned on, the Information bar displays a message 
saying "Pop-up blocked. To see this pop-up or additional options click here." You may then select 
this Information bar, and select the “Show Blocked Pop-up” option. 
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You may also allow pop-ups specifically for this course (or for other websites), so that you do not 
have to select the Information bar in order to show associated pop-ups. For Internet Explorer Version 
6.X: 
 

1. In your Internet Explorer browser window, select “Pop-up Blocker” from the “Tools” menu. 
2. Select “Pop-up Blocker Settings.” 
3. In the “Address of website to allow” field, type the address or URL of the website you want 

to see pop-ups from. 
4. Select “Add.” 
5. Select “Close” to save your settings. 

 
 
Plug-Ins 
Flash 10.0 (or higher) is required in order to use the course. The Flash player can be downloaded from 
the Adobe Flash Player website. Follow the instructions included with the Flash Player software to install 
it on your computer. 
 
Additionally, some documents are published using Adobe's Portable Document Format (PDF). To display 
or print these documents, you must either already have Acrobat Reader on your computer (version 5.0 or 
higher), or you need to download the free Acrobat Reader. The Adobe Acrobat Reader may be 
downloaded from the Adobe website. Follow the instructions included with the Acrobat Reader software 
to install Acrobat Reader on your computer. Then, select any PDF file to view, navigate, or print it.  
 
 
Enlarging Screen Text Size 
For persons with impaired vision, the screen text can be enlarged. In Internet Explorer Version 6.X, open 
the “View” menu, select “Text Size,” and then, choose a larger size than normal.  
 
If your mouse is equipped with a scroll wheel, you may hold the “Ctrl” key down on your keyboard, and 
use the scroll wheel to change the text size. 
 
 

http://www.adobe.com/products/flashplayer/
http://get.adobe.com/reader/
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